
Overview: Customizing the HiJaak Settings
You can customize HiJaak in the following ways:

Add or remove file associations 



Adding and Removing File Associations
You can specify which supported file formats are recognized by HiJaak. 

For example, HiJaak supports Photoshop® files. It can thumbnail and display any file with a PSD extension. However, you 
probably want most, if not all, of your PSD files to be associated with Photoshop. 

To edit file associations:
1. In HiJaak, select Tools|HiJaak File Association to display the File Association dialog.

2. In the list of formats, click the file format you want to associate with a particular extension

3. Click the check box of the    extension you want to associate to HiJaak. 

4. Click [OK].

HiJaak adds this extension to its list of recognized formats.

To remove format extensions:
1. In HiJaak, select Tools|HiJaak File Association to display the File Association dialog.

2. In the list of formats, click the check box next to the file format for which you want to remove the file association.

3. Click [OK].



Overview: Converting Files to Different Formats
You can convert image files to and from any of the most popular 14 formats supported by HiJaak Image Manager. You can 
convert images from the HiJaak application of any HiJaak supported image file.

Converting files is necessary when you want to use image files in an application that does not support the format of the files. For 
example, you may want to convert TIF files to JPG or GIF format to use on a Web page. 

Click here for a list of supported formats. 

File Types
HiJaak Image Manager supports the following types of files:

Raster images, also called bitmapped images, consist of thousands of dots, called pixels, that are arranged in a rectangular 
array called a bitmap. Raster images are usually created by scanners or paint software applications. All fax formats are 
raster.

Vector images consist of mathematically coded drawing objects, such as lines, curves, circles, and squares. Vector images can 
also contain font information. 

Metafiles consist of a combination of raster and vector components.

Digital Camera Files are created by digital cameras. Hijaak supports both FPX and KDC formats.



Overview: Conversion Methods
You can convert a file using any of the following methods:

Converting Files using the HiJaak File Menu 



Converting Files using the HiJaak File Menu
You can convert a single open image by using the Save As command from the HiJaak file menu. This method allows you to view 
and edit the image before you convert it. You can also convert one or more images using the Convert command from the File 
menu.

To convert a file using the Save As command:
1. In HiJaak, open the file you want to convert.

2. Select File|Save As to open the Save As dialog.

3. In the Save In list, select the drive and folder in which you want to save the converted file.

4. Use the Save As Type box to select the file type to which you want to convert the open image.

5. By default, HiJaak gives the converted file the same name as the original, but with a different file extension. If you want to 
enter a different name, double-click in the File name box and type a new name.

6. To start the conversion, click [Save].
HiJaak displays a progress bar indicating the status of the conversion. If the files are large, the conversion may take a 
while. When the conversion is complete, the converted file will be created in the destination location you selected. 



Keyboard Shortcuts
The following table lists the command keyboard shortcuts in HiJaak.

Command Keyboard Shortcut
Copy Ctrl+C

Help F1

Cut Ctrl+X

Paste Ctrl+V

Open Ctrl+O

Save Ctrl+S

Slide Show Ctrl+F

Specifying the Size of Thumbnails
You can specify the size of the Thumbnails that are displayed.

To specify the size of thumbnails:

1. Select View|Thumbnail Size.

2. Select 50%, 150% or 200%.    (The default setting is 100%)



      Introduction 
HiJaak is a tool for handling all of your graphics tasks. With HiJaak you can organize, find, convert, and edit graphics files. You 
can capture single images, animations, and entire Web sites. With support for the most popular 14 raster, vector, and metafile 
formats. For a list of supported file formats, click here. 

HiJaak creates thumbnail images of your graphics files and replaces the generic Windows large icons with these thumbnails. You
can then easily find the file you need by browsing through your graphic directories on CD, local hard drive, intranet or network.

Graphics files can be organized into specific directories or favorite’s directory.    To find out more, click the following topics:

Upgrading to HiJaak Pro 

Starting and Exiting HiJaak 

Getting Information on an Image 

Using the Internet Palette 



Upgrading to HiJaak Pro
HiJaak Pro supports over 115 different file formats, expanded editing features, batch processing and conversion, and provides 
powerful Palette and Opti-Palette features. You can load an existing palette or create one from an image file. You can change the
colors in a palette and choose a color to be transparent. You can save the customized palette and apply it to an image or an 
entire Batch Group. Opti-Palettes are custom palettes that you create from images in a batch group. The Opti-Palette feature in 
HiJaak Pro allows you to create a palette of colors based on all the images or selected images in a batch group.

To upgrade by phone:
Call IMSI Sales at 1-800-833-8082.

To upgrade on the Internet:
Visit the IMSI store at Shop at IMSI 



Starting and Exiting HiJaak
HiJaak can be started from the Windows Start menu.

To Start an application:
1. On the Windows Taskbar, click [Start].

2. Select Programs|IMSI HiJaak Image Manager 1.0.

3. Select the program you want to start. The programs include:
IMSI Capture: capture a Windows screen, area, or object.
HiJaak Image Manager : view, print, convert and edit images.

To exit an application:
Select File|Exit, or click [X] in the upper right corner of the application title bar.



Viewing the Properties of an Image

To view the properties of an image that's open in HiJaak:
1. Make sure the file for which you want to view properties is open or the thumbnail has been selected in HiJaak.

2. Select Edit|Properties.

Note:    The information displayed in the Properties dialog refers to the image on the disk, not to the changes you have made to 
the open image in HiJaak. Note that the file information changes only after you change the file, save it, and open the changed 
file.



Viewing Thumbnails
HiJaak automatically generates thumbnails for graphic images on your system:

To create thumbnails in the Open dialog of HiJaak:
1. Open HiJaak.

2. Select a directory containing graphics using the directory tree.

3. The thumbnails will begin to display.

Note:    HiJaak displays graphic thumbnails of any supported file formats. 



Using the Internet Palette
HiJaak provides you with on-the-fly access to the Internet via the Internet palette. When this option is activated and your system 
is connected to the Internet, a browser window is opened with links to HiJaak Support. From the Internet Palette, you can search
for answers to questions, update your software, participate in a HiJaak Forum, or send email to HiJaak Technical Support. You 
can also browse and search the IMSI Web site or enter any other Internet address. 

The toolbar of the Internet Palette provides the following options:

 Back Goes back to the previous Web page.

 Forward Goes forward to the next page (provided you have viewed it just previously).

 Stop Stops opening the file that you’ve just clicked to open.

 Print Prints the contents of the current Web page.

 Search Search the IMSI Web site.

 Online Opens or closes your Internet connection.



Licenses and Copyrights

Program License Agreement
IMPORTANT NOTICE: Please read the terms of the following License Agreement carefully. Your use of the product signifies your
acceptance of the terms of the Agreement. If you do not agree with the terms of this Agreement, you should promptly return the 
package; your money will be refunded. Retain this License Agreement for future reference.

Article 1: License Grant
The software is the intellectual property of IMSI® and its licensors, and is protected by law, including United States copyright 
laws and international treaties.

IMSI® grants to you a license:

1. To use the program on a single machine.

2. To make a single archival back-up copy of the program in support of your use of the single program on a single machine.

3. To modify the program and/or merge it into another program for use on a single machine.

4. To transfer the program to another party if that party agrees to accept the terms and conditions of this Agreement, and you 
do not retain any copies of the program, whether in printed, machine-readable, modified, or merged form. Except as 
expressly provided for in this license, you may not copy, modify, or transfer this program.

5. If the software in this package is licensed as a Site License, it is licensed for use on several machines. Additional master 
copies of the software may be made by the licensee, equal to the number of licenses purchased.

No reverse engineering. Except as stated above, YOU MAY NOT MODIFY, TRANSLATE, DISASSEMBLE, OR DECOMPILE 
THE SOFTWARE, OR ANY COPY, IN WHOLE OR PART.

Article 2: Term
The license is effective until terminated. You may terminate the license at any time by destroying the program together with all 
copies, modifications, and merged portions in any form. The license will also terminate upon conditions set forth elsewhere in 
this Agreement, and IMSI® may terminate your license if you fail to comply with this Agreement. You agree, upon such 
termination for any reason, to destroy the program together with all copies, modifications, and merged portions in any form.

Article 3: Disclaimer of Warranties and Limitations of Remedies
1. IMSI® software is licensed to you As Is. You, the consumer, bear the entire risk relating to the quality and performance of the

software. In no event will IMSI® be liable for direct, indirect, incidental, or consequential damages resulting from any defect 
in the software, even if IMSI® had reason to know of the possibility of such damage. If the software proves to have defects, 
you, and not IMSI®, assume the cost of any necessary service or repair. In the event any liability is imposed on IMSI®, 
IMSI®’s liability to you or any third party shall not exceed the purchase price paid for this product.

2. Thirty-day limited warranty on disks. IMSI® warrants the enclosed disks to be free of defects in material and workmanship 
under normal use for 30 days after purchase. During the 30-day period, you may return a defective disk to IMSI® with proof 
of purchase, and it will be replaced without charge, unless the disk is damaged by accident or misuse. Replacement of a disk
is your sole remedy in the event of a defect. This warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state.

3. THE LIMITED WARRANTY STATED ABOVE IS THE ONLY WARRANTY OR REPRESENTATION OF ANY KIND WITH 
RESPECT TO THE SOFTWARE MADE BY IMSI® OR ANY THIRD PARTY INVOLVED IN THE CREATION, PRODUCTION, 
DELIVERY, OR LICENSING OF THE SOFTWARE. IMSI® AND ANY SUCH THIRD PARTY DISCLAIM ALL WARRANTIES, 
EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, ITS QUALITY, RELIABILITY OR PERFORMANCE; OR 
ITS MERCHANTABILITY, NON-INFRINGEMENT OF THIRD PARTY RIGHTS, OR FITNESS FOR A PARTICULAR 
PURPOSE.

4. Some states do not allow the exclusion or limitation of implied warranties of liability for incidental or consequential damages, 
so the above limitations or exclusions may not apply to you.

Article 4: General 
You may not sub-license, assign, or transfer the license or the program except as expressly provided in this Agreement. Any 
attempt otherwise to sub-license, assign, or transfer any of the rights, duties, or obligations hereunder is void. 

This Agreement will be governed by the laws of the State of California, and you agree that any claims regarding the software 
shall be brought in California, and waive any objections to jurisdiction in the US District Court for the Northern District of 
California or the California Superior Court for Marin County.

You acknowledge that US laws prohibit the export/re-export of technical data of US origin, including software, and agree that you
will not export or re-export the software without the appropriate US and foreign government license.



Copyrights
HiJaak® and HiJaak Pro® © 1997–2001, IMSI. All rights reserved. HiJaak, HiJaak Pro, and the IMSI logo are registered 
trademarks of IMSI. © 2001 Image Manager™, ValuSoft, Inc.    All rights reserved.    Image Manager is a trademark and the 
ValuSoft logo a registered trademark of ValuSoft, Inc.

Portions of this software are based in part on the work of the Independent JPEG Group.

Copyright© 1988-1997 Sam Leffler

LZW compression licensed under U.S. Patent Number 4,558,302 and foreign counterparts.



Displaying the Image Alone on the Screen
The Image Only command in the View menu displays the image alone on the full screen: No windows, title bars or other 
Windows objects appear on the screen when this command is selected. 

To display the image alone on the screen:
1. Open the Image you want to display.

2. Double-click the thumbnail of the image in the thumbnail display area.
The image displays alone on the screen.

3. To return to the normal HiJaak display, double-click on the full-size image.



Overview: Editing Images
HiJaak allows you to edit images in many ways. See the following topics for more information:

Using the Windows Clipboard 



Opening and Saving
This section provides information on the following basic operations:

Opening an Image File 

Saving an Image File 



Opening an Image File
There are several ways to open a file in HiJaak.

To open a file when HiJaak is running:

1. Select an image thumbnail by highlighting it.

2. Select File|Open or press <Ctrl>+<O>.

3. Click [Open]. The image you selected appears on the screen.



Saving an Image File
You can save an image file with the same name or with a new name.

To save an image file with the same name:
With the image file open in HiJaak, select File|Save or press <Ctrl>+<S>. If the file is unchanged since the last time you saved, 
the Save option is not available.

To save an image file with a new name:
1. With the image file open in HiJaak, select File|Save As.

2. In the Save As dialog, enter a name and location for the file.

3. Click [Save].

Note:

You can use the Save As dialog to convert a file to a different format. For more information see Converting Files using the 
HiJaak File Menu .



Overview: Using the Windows Clipboard
You can cut, copy, and paste images between HiJaak and the Windows Clipboard. This is useful for easily moving a large 
number of files in various formats among applications in Windows. Since HiJaak supports many graphics formats, you will be 
able to use virtually all of them in any Windows application that supports pasting graphics from the Clipboard.

You can cut or copy an image to the Clipboard and open the application into which you want to paste the image without closing 
HiJaak. When you paste the image into the application, HiJaak provides the image in the format requested by that application. 

Any image that has been copied to the Clipboard can be pasted into HiJaak.

Pasting an Image into HiJaak 



Pasting an Image into HiJaak
1. Copy or Cut an image to the Windows Clipboard.

2. Select Edit|Paste As New Image or press <Ctrl>+<V>.

3. HiJaak creates a new image window titled "Untitled" and pastes the clipboard image into it.

4. To save the image, select File|Save As.



Overview: Adjusting Images
The Image menu provides commands for adjusting the size, shape, orientation, contrast, and brightness of images.

Resizing Images 

Cropping Images 

Flipping Images 

Rotating Images 



Resizing Images
The Resize command is available only for raster images. You can resize raster images to fit in a frame, a certain width, or a certain 
height. You can also choose whether to maintain or distort the image’s aspect ratio. 
You can change the size of an image during a conversion, using the sizing options in the Processing Options dialog.

To change the size of an image:

1.          In HiJaak, open the raster image you want to resize.
2. Select Edit|Resize.
3. To set the unit of measure that will be used in this dialog, choose Percentage or Pixels. 
4. If you do not want the height or the width of the image to stretch and distort by a specific factor, set Lock Aspect Ratio. 
5. To specify the maximum width or height, click in the Horizontal or Vertical boxes and type the number of units you want. 

The units of measure used will be those specified in the drop-down list. 
6. Click [OK].



Cropping Images
Using the Crop command in the Image menu, you can trim an image to any rectangular area. 

To crop an image
1.    In HiJaak, open or double-click on the image you want to crop.

2.     Select Edit|Crop.

3.     When you position the pointer over the image, it appears as a crosshair icon. Move the pointer to a corner of the area you 
want to crop. 

4.     Click and hold down the mouse button; then drag the mouse to define the area you want to keep after cropping. 

5.     Release the mouse button to remove the area outside the boundary you have defined.



 Flipping Images
You    can flip an image either vertically or horizontally to create a mirror image.

To flip an image:
1. In HiJaak, open the image you want to flip.

2. Select Edit|Flip|Horizontal to flip the image horizontally, or Edit|Flip|Vertical to flip the image vertically.



 Rotating Images

Using the Rotate command in the Edit menu, you can rotate an image from 0 to 360 degrees, clockwise or counterclockwise.
You can rotate or flip images during a conversion by selecting the [Rotation Options] tab in the Processing Options dialog. The 
converted image will be rotated the number of degrees you specify.

To Rotate an Image:
1. In HiJaak, open the image you want to rotate.
2. Select Edit|Rotate, and then select one of the following options: 90 degrees Clockwise, 90 degrees Counterclockwise, 180 

degrees, or Custom.
3. If you selected Custom, the Processing Options dialog opens. Click the up or down arrows in the Angle box to increase or 

decrease the number of degrees of rotation, or click the Rotation Dial on the point representing the number of degrees you want 
to rotate. The thumbnail sample rotates the number of degrees you select. Click [OK] to select the specified rotation. You can 
also Flip an image in this dialog.



Technical Support

If you do not find the answer to your question in the User Guide or Online Help, contact IMSI technical support at:

Email:    supportjb@uswest.net
Paid phone support: (505) 294-5409

Our support policies and contact information are subject to change at any time.    Please check http://www.imsisoft.com/support 
for the latest information.



Viewing Animation in Animated GIF's

To view an the animation in an animated GIF:

1. Select the thumbnail of the file.
2. Drag the thumbnail to the Internet Palette (upper-left window)
3. Watch the animation.



Supported File Formats

File Format View Convert To
BMP - Windows Bitmap ü ü
DIB - Windows Bitmap ü ü
EMF - Enhanced Windows 
Metafile

ü

FPX - FlashPix ü ü
GIF - CompuServe ü ü
JPG/JPEG ü ü
KDC - Kodak Digital Camera ü
MAC - MacPaint ü ü
MSP - Microsoft Paint ü ü
PCD - Kodak Photo CD ü
PNG - Portable Network 
Graphic

ü

PSD - Photoshop ü ü
TIF/TIFF - Tagged Image 
File

ü ü

WMF - Windows Metafile ü
Important Note: In addition to the formats listed above, almost any image can be brought into 
HiJaak Image Manager by using the Capture feature:

1. Open any image in it’s native application.
2. Launch HiJaak Capture by either selecting Start|Programs|IMSI HiJaak Image Manager 1.0|HiJaak 

Capture or from the Title bar menu in HiJaak, select Tools|Capture.
3. Select the type of format you wish to save the file as (BMP or GIF)
4. Select Area- Rectangle (Area-Rect) which launches a cropping-like tool.
5. Using this tool, click on the upper-left corner of your image and hold the left mouse button down.
6. Drag the cursor to the bottom-right corner of the image and release.
7. This will save the image as a high-quality BMP or GIF that can then be viewed, edited or converted 

in HiJaak Image Manager.

Ø Using this method, text and text files become graphic images and can no longer be edited.
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